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Uovom poglavlju

v’ Upoznavanje s programom
Photoshop Elements

v’ Opsecanje slika
v Menjanje velicina slika

v’ Optimizovanje grafike
u formatu GIF

v Optimizovanje fotografija
uformatu JPEG

v Kombinovanje fotografija
i teksta na novoj slici

v Obrada slika sa vise slojeva

v Koridcenje specijalnih
efekata

h

Web grafike

G eneracije vlasnika malih preduzeca nosile su svoje mar-
ketinSke i dizajnerske projekte Stamparima koji su pa-
zZljivo Stampali fotografije, a u programima za prelom strana
dizajnirali su portfolije, broSure i drugi reklamni materijal za
ta preduzeca.

Sada sve viSe vlasnika malih preduzeca sami obavljaju taj
posao, zahvaljuju¢i moc¢nim alatkama jednostavnim za upo-
trebu, u koje se ubraja i Photoshop Elements. Kad bi ih mogli
videti njihovi dedovi (neke moZda i vide), zacudili bi se na
koliko nacina se moZe napraviti, obraditi i izmeniti graficki
dizajn.

U ovom poglavlju otkricete neke od najneobicnijih stvari
koje moZete uraditi u programu kao Sto je Photoshop Ele-
ments. Naucicete kako da pravite slike, na primer banere i
dugmad na Web stranama, da im menjate veliCinu, opsecate
ih i doterujete.

Ovde vas Cekaju i postupna uputstva za izradu i optimizo-
vanje grafike koja se brzo preuzima s Weba — a to je vero-
vatno najbitnije u ovoj knjizi o izradi Web strana.

Zadatke navedene u ovoj knjizi moZete uraditi i u mnogim

drugim programima za obradu slika. Adobe Photoshop Elements preporucujem
zato §to je zasnovan na standardu u oblasti obrade slika, programu Adobe Pho-
toshop CS3, ali se mnogo lakse koristi i znatno je jeftiniji. Za primere u ovoj
knjizi koristim Elements 5, mada i u ranijim verzijama programa postoje opcije
potrebne da se obave opisani zadaci.
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Uvod u Photoshop Elements

Photoshop Elements je ogoljena verzija svog starijeg brata, Adobe Photoshopa,
ali je ipak mocna alatka. Radni prostor, prikazan na slici 4-1, sveden je i jedno-
stavan ali ima brojne alatke i palete — i pregrst opcija za obradu i snimanje slika
za Web. Adobeovi inZenjeri napravili su okruZenje tako da sve alatke budu ras-
poredene po ivici ekrana kako biste dobili maksimalnu radnu povrSinu u sredi-
ni, mada palete moZete da otvarate, zatvarate i razmesState po ekranu onako
kako vam najviSe odgovara.
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Slika 4-1: Photoshop Elements nudi sirok spektar alatki i paleta razmestenih po obodu glavnog
radnog prostora u kome pravite i obradujete slike.

Da biste se upoznali s programom pre nego Sto predete na zadatke, u ovom
odeljku govorim o tome kako je organizovan radni prostor u programu Photo-
shop Elements i opisujem njegove glavne elemente: kutiju sa alatkama, traku
Options, meni i palete. Kad prvi put pokrenete Photoshop Elements, pojavljuje
se uvodni ekran sa Sest mogucnosti. Da biste pristupili glavnim opcijama za
obradu, kojima su posveceni naredni odeljci, izaberite Edit and Enhance Photos.

Kutija sa alatkama

Pre nego §to iSta uradite, recimo pre nego Sto opsecete sliku, morate da izabe-
rete odgovarajucu alatku iz kutije sa alatkama (engl. toolbox). To je jedna od
prvih stvari na koju treba da se naviknete kad koristite program kao Sto je Pho-
toshop Elements. Kutija sa alatkama u ovom programu slicna je po mnogo
cemu kutiji sa alatom koju drzite u garazi: kad treba da ukucate ekser, uzmete
cekié, a odvijac upotrebite kad neSto hocete da pritegnete.
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Alatka iz kutije lako se bira: samo pritisnite ikonicu alatke, na primer ikonicu
sa slovom T za dodavanje teksta slici. TeZi deo je da znate Cemu koja alatka
sluzi (sli¢no kao Sto treba da znate kad se koristi pljosnati odvijac, a kad krsta-
sti). Neke alatke se lako prepoznaju: Cetkica sluZi za slikanje, ali pojedine alatke,
na primer pecat za kloniranje, u pocetku vas mogu zbunjivati.

Lista alatki na slici 4-2 pomoci ¢e vam da sagledate kakve su vam opcije
ponudene u kutiji sa alatkama.

Alatka za pomeranje (Move) ——h;. Zumiranje (Zoom)

Saka (Hand) ——'"" Pipeta (Eyedropper)

Pravougaoni okvir za izbor r—
(Rectangular Merquee) ™ [ L_4

Laso (Lasso)

Carobna &etkica
(Magic Selection Brush)

Q
yri'
=
.
Alatka za tekst (Text) ——rI: H Alatka za opsecanje (Crop)
=L
&,
=/
]
L

Carobni $tapi¢ (Magic Wand) —— %,

Isecanje oblika (Cookie Cutter) :-,"

Alatka za korigovanje __ | 1.
crvenih ociju (Red Eye) = |

Pecat za kloniranje (Clone Stamp) ——.'?_L

Ispravljanje (Straighten)

Cetkica za doterivanje (Healing Brush)

Gumica za brisanje (Eraser)

Olovka (Pencil) ——‘;f‘
Preliv (Gradient) —-_|

Kanta s bojom (Paint Bucket)

Pravougaonik (Rectangle)

Razmazivanje (Smudge) ——%c/"‘ @ Zatamnjivanje (Burn)
y L . b
PodeSavanje boje prednjeg |
plana (Set Foreground color)

Slika 4-2: Kutija sa alatkama nudi Sirok spektar opcija za obradu slika.

Evo zanimljivog podatka: pojedine alatke skrivene su u priru¢nim menijima
drugih alatki. Ako dugme na kutiji sa alatkama ima trougli¢ u donjem desnom
uglu, to znaci da je sa istog dugmeta dostupno viSe alatki. Da biste pregledali
ostale alatke dugmeta, drzite pritisnutu vidljivu alatku sve dok se ne pojavi
priru¢ni meni, kao na slici 4-3.
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Slika 4-3: Prirucni meniji otkrivaju vise opcija istog dugmeta u kutiji sa alatkama.

lako cete mnoge alatke koristiti u zadacima iz knjige, dok budete pravili ili
obradivali slike za Web, nemoguce je da opiSem sve funkcije programa Photo-
shop Elements u ovom uvodu o Web grafici. (Kad bih to uradila, ne bi ostalo
prostora da iznesem ostale bitne aspekte Web dizajna.) Ako hocete da naucite
vi§e o izradi i obradi slika, procitajte knjigu Photoshop Elements For Dummies,
autora Barbare Obermeier i Teda Padove (Wiley Publishing), ili (ukoliko vas
zanimaju naprednije tehnike) Photoshop CS3 Bibliju, autora Laurie Ulrich Fuller
i Roberta C. Fullera (Mikro knjiga).

Alatke u kutiji mogu biti rasporedene jedna ispod druge bo¢no od radnog
prostora (kao na slici 4-1). Kutiju sa alatkama moZete prevuci bilo gde drugde i
podesiti da alatke budu u dve kolone (kao na slici 4-2).

Traka Options

DuZ gornje ivice radne povrSine u programu Elements, smestena je traka Opti-
ons (slika 4-4). Traka Options se sastoji od padajucih lista, polja za potvrdu i
radio-dugmadi. Svi ti elementi se mogu koristiti za podeSavanje parametara bilo
koje izabrane alatke. Na primer, kad izaberete slikarsku Cetkicu, dostupne su
opcije za promenu velicine i oblika poteza koji ¢ete povuci kad pritisnete Cetki-
cu i predete njome preko slike. Prebacite se na alatku za tekst, i traka Options
Ce se prilagoditi tako da se prikazu opcije za promenu vrste i velicine fonta.

D

Fancy Fonts

TR

Slika 4-4: S trake Options lako se pristupa parametrima svake alatke, na primer opcijama za vrstu
i velicinu fonta ako je izabrana alatka Text.
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Umesnost ponistavanja i ponovnog biranja operacije

Uz sve funkcije, filtre i opcije za uredivanje
koje nudi Photoshop Elements, najcesce je
najbolje drzati se strategije pokusaja i po-
gredaka - $to je lako kad su vam dostupne

opcije Undo, Redo, ¢ak i Revert ako treba da

vratite sliku u stanje kad ste je posledniji put

snimili.

Ako hocete da nesto izmenite na slici,ali
se potom predomislite, odaberite Edit =
Undo da biste ponistili prethodni potez.
Ukoliko niste sigurni jeste li ista dobili tim
ponistavanjem, pritisnite prvo Undo pa

onda Redo kako biste uporedili sliku pre i
posle primene efekta. U programu Photo-
shop Elements moguce je vratiti se mnogo
koraka unazad pomocu opcije Undo, stoga
mozete i¢i napred-nazad sve dok ne postig-
nete da slika izgleda onako kako hocete.

U slucaju da ste ljubitelj precica s tasta-
ture, pritisnite Ctrl+Z da biste primenili op-
ciju Undo u Windowsu (odnosno 3+Z na
Macu); za Redo, pritisnite Ctrl+Y (38+Y na
Macu).

Traka menija

Nijedan program nije kompletan bez trake s menijima pri vrhu radne povrsine
(slika 4-5). Pritisnite ime menija da biste ga otvorili i izabrali neku od njegovih
komandi i opcija za obradu. Ako su iza imena komande ispisane tri tacke (...),
kad pritisnete to ime otvara se okvir za dijalog u kome moZete primeniti niz op-
cija. Ako nisu, komanda se aktivira automatski ¢im je izaberete.

1.8

PR amg

Slika 4-5: 1z menija se pristupa vecini funkcija programa Photoshop Elements, medu kojima

je imoja omiljena - opcija Undo.
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Palete

Kao u svim Adobeovim aplikacijama, radni prostor u programu Elements pun je
paleta — malih prozora sa opcijama za formatiranje i drugim parametrima. Broj-
ne palete vam pomazu prilikom obrade i provere slika. Da biste otvorili paletu,
izaberite je iz menija Window. Na primer, kad odaberete Window = Color Swat-
ches, otvara se paleta sa opcijama za boje. Obratite paznju na to da svaka pale-
ta ima dugme More; pritisnite dugme More i pojavice se lista s dodatnim
komandama.

Paletu ostavite u koloni na desnoj strani radnog prostora, ili je prevucite na
glavnu radnu povrsinu, kao na slici 4-6, na kojoj sam upotrebila paletu Special
Effects kako bih primenila senku na izabrani tekst na slici. Da biste premestili
paletu, pritisnite je i povucite za jezicak, pa je spustite gde vam odgovara. Kad
paletu odvojite od glavnog prozora aplikacije, ona dobija sopstvenu naslovnu
traku radi lakSeg premestanja i identifikacije.
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Slika 4-6: Paletu mozete premestiti tako da bude blize onome na cemu trenutno radite.
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Opsecanje slike
§ . b Buduci da su fotografije na Webu uglavnom male,
tavam je potrebno opsecite delove koji nisu bitni - to je jedan od nacina
v Adobe Photoshop Elements da se vide svi vazni delovi. Kad opsecate sliku za

Web, najbolje je da se usredsredite na kljuCne ele-
mente slike. MozZete da iseCete vrh, dno, bo¢ne strane
ili koji god deo hocete, s prilagodljivim ivicama alatke
za opsecanje (Crop).

(ili slican program)
v Digitalna fotografija

Vreme:
. Manje od pola sata U ovom zadatku koji se izvr§ava korak po korak, pre-
P bacujete fokus na glavne elemente tako Sto uklanjate
pozadinu pomocu alatke za opsecanje.

N

1. Otvorite sliku u programu Ele-
ments, pa iz palete Tools izaberite
alatku za opsecanje. Posto odse-
Cene delove slike ne moZete da
povratite nakon Sto snimite i zatvo-
rite datoteku sa slikom, najbolje je
da ne radite na originalnoj slici
nego na njenoj kopiji.

~
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2. Pritisnite i prevucite misem
po slici kako biste definisali
podrucje koje hocete da isecete.
Sve izvan okvira za opsecanje
uklanja se kad zavrSite postupak.
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3. Da biste povedali ili smanijili okvir za
opsecanje, povucite rucice na uglo-
vima ili ivicama oblasti za opsecanje.

4. Da biste dovrsili opsecanje, dvaput
pritisnite u sredini izabrane oblasti
ili pritisnite ikonicu Commit (zeleni
znak za potvrdu) u donjem desnom
uglu okvira za opsecanje. Da biste
iskljucili alatku za opsecanje, a da ne
opsecete sliku, pritisnite dugme Can-
cel (crveni krug s linijom po sredini).

5. Kad dovrsite opsecanje,
bice uklonjene oblasti slike
koje su ostale van okvira za
opsecanje a ukupna veli-
Cina slike proporcionalno
¢e se smanjiti. Alatka za
opsecanje aktivna je sve
dok ne izaberete drugu
alatku iz kutije sa alatkama.

Ponavljajte korake od 2 do 5 za dodatno opsecanije. Izaberite Edit => Undo kako histe
ponistili opsecanije ukoliko niste zadovoljni rezultatom. Kad snimite sliku, trajno joj
menjate izgled.
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Promena velic¢ine slike

= . Menjanje veliCine slike vazno je iz dva razloga: slike
treba da budu dovoljno male kako bi se dobro prikazi-
v Adobe Photoshop Elements vale na ekranu. Sto vise smanjujete sliku, to je manja i
njena datoteka, a slika se brZe ucitava. Da biste

povecali ili smanyjili sliku, treba da promenite velicinu
slike ili platna. Uradite sledece:

(ili slican program)
v Digitalna fotografija

Vreme:
g, Manje od pola sata

1. Otvorite sliku u programu
Elements, pa izaberite
Image => Resize. Ako ne
Zelite da pokvarite origi-
nalnu sliku, napravite
njenu kopiju pa njoj pro-
menite veli¢inu kako biste
je prilagodili za Web
lokaciju.

2. U okviru za dijalog Image Size za-
dajte visinu i Sirinu slike. U ovom
primeru, smanjila sam sliku za
50 procenata. Okvir za dijalog
Image Size moZe vas isprva zbuniti
jer ima viSe opcija za promenu ve-
licine i rezolucije slike. Primenite
jednostavnu strategiju: koristite
polja u oblasti Pixel Dimensions
u gornjem delu okvira za dijalog.
Pomocu tih opcija menjajte visinu
i Sirinu slike na zadatu veliCinu u
pikselima, ili procentualno pove-
¢ajte odnosno smanjite sliku, kao
u ovom primeru. (Kad to radite,
treba da budu izabrana polja Scale
Styles, Constrain Proportions i
Resample Image u donjem delu
okvira za dijalog.)
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Pravljenje i otvaranje slika u programu Elements

U programu Photoshop Elements mozete
da otvorite postojecu sliku ili da napravite
potpuno nove slike, te da na ekranu imate
vise otvorenih slika u isto vreme, sto vam
olaksava kombinovanje slika i rad na sloze-
nijem dizajnu.

Da biste napravili nov dokument, oda-
berite File &> New, pa u okviru za dijalog
New File zadajte Height, Width, Resolution,
Color Mode i Background color. Kad napra-
vite sliku, mozete dodatno izmeniti bilo koji
parametar.

Da biste otvorili postojecu sliku, izaberi-
te File ©> Open, pronadite odgovarajucu sli-

ku na disku, pritisnite je da biste je izabrali,
pa pritisnite Open. Slika se pojavljuje u no-
vom prozoru u kome je mozete obradivati.

Ukoliko pokusate da otvorite sliku, a ne
vidite je u direktorijumu na disku iako znate
da bi trebalo da je tamo, promenite opciju
Files of Type (pri dnu okvira za dijalog Open)
u All Formats. Sada bi trebalo da se prikaze
lista svih slika u datom direktorijumu.

Kad pravite novu sliku u programu Pho-
toshop Elements, mozZete da zadate mnoge
parametre, medu njima i veli¢inu, rezoluciju
i boju.
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3. Ako unesete znak za potvrdu u polje
Constrain Proportions pri dnu okvira

za dijalog Image Size, sve promene
visine automatski se odraZavaju i na

Sirinu (i obrnuto), tako da proporcije

slike ostaju nepromenjene i nakon
promene visine ili Sirine.

4. Pritisnite OK da biste promenili velicinu slike.

Ako hocete da sliku vratite na prethodne dimen-

zije, izaberite Edit => Undo. Kad snimite sliku,
unete izmene su trajne. Zapazite da se veliCina
datoteke promenila pa je s prvobitnih 1,59 MB
smanjena na 407 MB. Kad fizicki smanjite sliku,
drasti¢no se smanjuje i veliCina datoteke slike,
Sto znaci da se slika brze ucitava na Internetu.

Najcesce mozete zadrzati podrazumevane parametre, osim ako unapred znate da cete
naknadno menjati rezoluciju slike. (Uputstva za promenu rezolucije navedena su ka-
snije u ovom poglavlju, u odeljcima , Optimizovanje grafike u formatu GIF ili PNG" i
.Optimizovanje fotografija u formatu JPEG".) Slike bi, u nacelu, trebalo da obradujete
u srazmerno visokoj rezoluciji, a veli¢inu im smanjujte kad budete spremni da snimite

konacnu verziju za Web.
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Optimizovanje grafike u formatu GIF ili PNG

< R Dugo se smatralo da je format GIF najpodesniji za
crteZe, stripove i ostale slike koje imaju malo boja.
v Adobe Photoshop Elements (U narednim odeljcima videcete da je format JPEG
idealan za fotografije i druge slike s milionima boja.)
Format GIF takode najviSe odgovara kad pravite slike
s providnom pozadinom, kad postiZete da slika,lebdi“
na Web strani. Kako je Web sazrevao, popularnost je
stekao treci format, PNG. Format PNG superiorniji je
od formata GIF u svim aspektima osim u jednom: stariji
Citaci Weba bolje podrzavaju GIF slike, narocito u
pogledu providnosti.

(ili slican program)
v Digitalna fotografija
sa ogranicenim brojem boja

Vreme:
o5 Manje od pola sata

Da biste postigli da se sadrzaj Web strana prikazuje
podjednako dobro na racunarima svih posetilaca
vase lokacije, odlucite se za format GIF. Ukoliko hocete da slike izgledaju maksimalno
dobro s minimalnom veli¢inom datoteka slika, bolje rezultate postici cete s formatom
PNG. Ako pretpostavljate da ¢e posetioci koristiti starije verzije Citaca Weba, bolji
izbor je GIF. U narednoj vezbi koja se izvrSava korak po korak, odlucila sam se za
sigurnu varijantu i odabrala format GIF, ali proces je gotovo isti bez obzira na to koji
format koristite.

Kad koristite format PNG ili GIF, moZete da skratite vreme ucitavanja tako Sto cete
smanjiti broj boja na slici. Zato su ti formati idealni za grafiku kojoj je potrebno malo
boja da se valjano prikaZe, a to su crteZi ili jednostavno dizajnirani logotipi. Smanju-
judi broj boja na slikama snimljenim u formatu PNG ili GIF, uklanjate nepotrebne boje.
Ako odstranite previSe boja, promena ce biti drasti¢na (a slika ce izgledati uzasno); ali
ukoliko ostavite samo ogranicen broj neophodnih boja, mozda necete ni primetiti ra-
zliku, a slika ¢e se ucitavati brze.

U zadatku koji se izvrSava korak po korak, otkri¢ete najbolji nacin da smanjite broj
boja na slici i da je snimite bilo u formatu PNG ili GIF u programu Photoshop Elements.

1. Napravite novu sliku ili otvo-
rite postojecu u bilo kom
formatu u programu Photo-
shop Elements. PoSto ste
snimili kopiju slike kad ste
primenili opciju Save for
Web, necete brinuti o pro-
meni originalne slike.




60

Deo lI: Izrada Web strana

[T ———
Vs smpia & ) o s sl s
i R et S s fapes o ks g B e

A
F
-

s
-

Ju

P
maes
=y

——T ]

2. Izaberite File & Save for Web. U okviru za dijalog Save for Web, izaberite GIF iz

padajuce liste Optimized File Format.

Zasto samo 72 ppi?

Kad snimate slike za Web, trebalo bi da ih
snimite u rezoluciji od 72 piksela po incu
(ppi) u okviru za dijalog Image Size. (Videti
odeljak ,Promena velic¢ine slike; ranije u
ovom poglavlju.) Vecina racunara ne prika-
zuje vise od 72 ppi, pa bilo koja veca vredn-
ost ne znadi nista za prikazivanje na Webu

jer bi u tom slucaju posetioci ucitavali vise
piksela nego $to se na njihovim monitorima
moze prikazati. Ali ako hocete da Stampate
sliku, treba vam Sto vise piksela. Upravo
zato vecina slika koje vidite na Webu izgle-
da vrlo lose kad se odstampa.
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3. U slu¢aju da Stampate sliku s pro-
vidnom pozadinom, izaberite op-
ciju Transparency pa zadajte tzv.
mat boju (engl. matte color). Mat
boja bi trebalo da se podudara s
bojom pozadine Web strane na
kojoj je postavljena slika. Koristeci
podudarnu mat boju, sprecavate da
ivice slike budu krzave. Da biste
promenili tu boju, u gornjem levom
uglu okvira za dijalog izaberite pi-
petu pa pritisnite polje Matte kako
biste otvorili paletu boja na kojoj
moZzete izabrati boju. Boju na slici
moZete da izaberete i ako pritisnete
sliku pipetom.

— Prezet: — Custom o —@—

GIF b [ Jintadaced
Adaptive e Colors: |2 B
Dither: E 2
4
Transpar'enn:ﬁ,r Mathe: E 8
Dﬂnimate 16
a2 =
— Image Size
OHginal Size —————— 128
Inlidth: 293 pivels 256
Height: 180 pixels

| Ok |
| Cancel |
® | Help ]

— Preset: — Custom W |_®‘
GIF W [ Jintedaced
Adaptive w Colors:

Dithar: | 1003 >

[w] Tranzparency Iatta: L

D.ﬁ.nimate Mone

— Irnage SiTE gl  Eyedropper Color k

Criginal Siz .
White
Inlidth: 2<
' Black
Height: 1%
Other...
- MHewe Size T

4. Datoteku sa slikom smanjicete ako
smanjite broj boja — upiSite broj manji
od 256 u polje Colors ili izaberite una-
pred definisanu vrednost iz padajuce
liste Colors. U ovom primeru, broj
boja je smanjen sa 256 (Sto je maksi-
malan broj boja u formatu GIF) na 64.

5. Pri dnu okvira za za dijalog
Save for Web zapazicete da se
ispod prikaza slike levo poja-
vljuje prvobitna veli¢ina dato-
teke, dok se optimizovana

veliCina datoteke prikazuje
ispod prikaza na desnoj
strani. Uporedite te brojke da
biste videli koliko je slika
manja nakon Sto ste smanjili
broj boja s 256 na 46. U ovom
primeru, vidite da je smanje-
njem broja boja datoteka sa
et slikom smanjena sa 155 KB na
. 4,63 KB.
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6. Smanjujte dalje broj boja
kako biste jos visSe smanjili
datoteku sa slikom - ali ne

preterujte. U ovom primeru,

slika je svedena samo na

dve boje pa se beo tekst Ma-

libu, California ne vidi zato
Sto nije zadrzano dovoljno

boje na slici kako bi se prika-

zala plava pozadina, crveno
ispisan tekst Zuma Beach i
beo tekst. Obratite paznju i
na to da crvena slova u pri-
kazu desno viSe nisu glatka.
lako se Cini da su na slici
samo dve boje, mnoge vari-
jacije plave i crvene isko-
riS¢ene su kako bi se
napravila jasna granica iz-
medu teksta i pozadine. Sa
samo dve boje na slici, glat-
ka ivica postaje krzava.
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7.

Podesavajte broj boja i
ostale parametre sve dok na
slici ne ostane minimalno
boja (samim tim bi¢e mini-
malna i datoteka sa slikom)
a da to ne narusi kvalitet
slike. U ovom primeru, broj
boja na slici smanjen je na
32, a veliCina datoteke na
4,355 KB.

8. Kad sve parametre slike podesite onako kako Zelite, pritisnite OK. U
okviru za dijalog Save imenujte sliku i odredite gde cete je snimiti na

disku. Zatim pritisnite Save.

SNET

Kad koristite okvir za dijalog Save For Web, Elements automatski snima kopiju slike u

novom formatu, ne menjajudi originalnu sliku.
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Optimizovanje fotografija u formatu JPEG

Stavam je potrebno

v’ Adobe Photoshop Elements
(ili slican program)

v Digitalna fotografija s
milionima boja

Vreme:
o5 Manje od pola sata

1. Napravite novu sliku ili

otvorite postojecu u bilo
kom formatu u programu
Photoshop Elements. Posto
prilikom rada u okviru za
dijalog Save for Web pravite
kopiju slike, ne treba da bri-
nete o tome hocete li izme-
niti originalnu sliku.

Format JPEG je najbolji izbor za slike s mnogo boja,
kao Sto su fotografije ili slike sa senkama ili prelivima.
Sve slike moZete snimiti u formatima GIF, PNG ili JPEG
preko okvira za dijalog Save For Web, ali najbolje
rezultate postiZete ako izaberete najprikladniji format
za svaku pojedinacnu sliku. To je zato Sto najbolji
nacin da optimizujete slike (tj. postignete da se brze
ucitavaju na Webu) zavisi od toga koliko boja se poja-
vljuje na slici.

Cak i kad je fotografija ve¢ u formatu JPEG, uvek
mozZete smanjiti njenu datoteku (i ubrzati u€itavanje)
u okviru za dijalog Save for Web kako biste optimizo-
vali sliku, Sto je opisano u slede¢im koracima:

2. Izaberite File = Save for
Web, pa u padajucoj listi
Optimized File Format
okvira za dijalog Save for
Web odaberite JPEG.

JE AR
il
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_ 3. Ako je slika veca od oblasti za prikaz

-;I Taem mm Emapn w eriain n g b o
| e
)
]
i “in sl
o jmis
4. Da biste smanijili datoteku sa JPEG sli-

kom, pomocu klizaca promenite parame-

tar Quality ili upiSite broj (maksimalna
vrednost je 100). Kompresija se meri u

procentima: Sto je nizi broj, veca je kom-

presija a manja datoteka.

&
F i ¥

u okviru za dijalog Save for Web, kao
u ovom primeru, odaberite alatku
Hand (Saka) u gornjem levom uglu
okvira za dijalog. Zatim pritisnite i
povlacite da biste pozicionirali naj-
vaZnije elemente na slici, tako da pri-
kaz bude bolji. Mozete da promenite i
velicinu prikaza slike. Prikaz slike pri-
tisnite desnim tasterom misa pa
izaberite opciju Fit on Screen ili bilo
koji parametar uvecanja.

[ K ]

( Cancel ]

® [ Help ]
= |_

— Preset: —{Custnm

JPEG W

High w | Quality: (75 [
[JProgressive £

[]1ce Profile Matte: | Mihe | %

5. Pri dnu okvira za za di-
jalog Save for Web,
ispod prikaza slike levo
pojavljuje se prvobitna
velic¢ina datoteke, dok
se veliCina optimizova-
ne datoteke prikazuje
ispod prikaza na desnoj
strani. U ovom primeru
je pri podesenoj vred-
nosti 75 za opciju Quali-
ty, veliCina datoteke sa

slikom smanjena sa
1,36 MB na 130,2 KB.
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6. Podesavajte parametar Quali-
= ty sve dok ne postignete mak-
- simalnu kompresiju (Sto je
veca kompresija, manji je
broj u polju Quality), a da se
pri tom bitno ne narusi kvali-
tet slike. U ovom primeru,
parametar Quality smanjen

je na 50 kako bi se datoteka

svela na 69,75 KB, §to je

manje od polovine veliCine
datoteke kad je parametar
Quality bio podeSen na 75.

7. Dok podesavate opciju Qua-
lity, budno motrite na pri-
kaz. Ako previSe smanjite
kvalitet, vidno cete pokvariti
sliku.

== e

Kad sve parametre slike podesite onako kako Zelite, pritisnite OK.

U okviru za dijalog Save imenujte sliku i odredite gde cete je sni-
miti na disku. Zatim pritisnite Save kako biste snimili novu verziju
JPEG slike sa zadatim parametrima i sacuvali neizmenjen original.

Povecavanje i smanjivanje prikaza slike

Dok radite na slikama u programu Photo-
shop Elements, ¢esto je korisno da smanjite
ili povecate prikaz kako biste mogli videti
vecideo slike na ekranuili uve¢ane elemen-
te koje hocete da obradite.Za promenu ve-
licine prikaza slike na ekranu, koristite
alatku Zoom.

Prvo pritisnite i tako izaberite alatku za
promenu velicine prikaza u kutiji sa alatka-
ma. Zatim pritisnite bilo gde na slici kako bi-
ste uvelicali prikaz. Prikaz smanjujete ako
sliku pritisnete drzeci taster Alt (u Win-
dowsu), odnosno Option (na Macu). Evo sa-
veta: kad promenite veli¢inu prikaza,

mozete utvrditi koliko bi trebalo da prome-
nite stvarnu veli¢inu slike kako bi se ona po-
javila na ekranu kao $to ste zamislili. Da
biste to uradili, primenite alatku Zoom i po-
desite velicinu slike na najprikladniju za
Web stranu, pa vidite koliko to iznosi u pro-
centima (vrednost je prikazana pri vrhu
ekrana, pored imena datoteke). Tako cete
saznati koji broj treba da upisete u polje
Size okvira za dijalog Image Size kad menja-
te velicinu slike u procentima.

Da biste ponovo prikazali sliku u pravoj
velicini, dvaput pritisnite alatku Zoom.
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Kombinovanje fotogrdfija i teksta na novoj slici

§ . b Pravljenje nove slike od fotografija i teksta skoro je
tavam je potrebno podjednako jednostavno kao obrada postojece slike,
v Adobe Photoshop Elements recimo banera ili dugmadi koji su ubaceni u Sablone

(ili slican program koji opisane u ovoj knjizi.

podrzava slojeve) U nacelu, smatram da je najbolje prvo napraviti novu
v Digitalne fotografije sliku u programu Photoshop Elements i kopirati u nju
fotografije ili drugu grafiku koju hocete da koristite.

Vreme: Kad postavite te elemente, lako cete dodati tekst i sve
Oko pola sata to spojiti u celinu. Samo pratite sledece korake da
P biste sami napravili banere i dugmad:

(ako se ne zanesete)

7. U programu Photoshop Ele- (]

menjcs, 1zaber1t§ Flle (= N(.ew ‘ D s b Cart B =g
da biste napravili novu sliku i I (e 3 —_—
zadali joj veliCinu, rezoluciju,

te boju pozadine. Ovde mi je e — Z

zadatak da napravim sliku fa| X e -

Sirine 500 piksela, visine 380 pmulutary | 2 .

piksela, u rezoluciji od 72 ppi, =y BLTIS e

s modelom boja RGB i belom g W] : S e
pozadinom. . i

g = 2., Ako paleta Layers nije
i i otvorena bocno od
radne povrSine, izabe-
rite Window = Layers
da biste je otvorili.
(Mora biti otvorena
ako hocete da pratite
Sta se deSava sa sloje-
vima koji se automatski
prave prilikom kopi-
ranja slika ili doda-

|: | vanja teksta slici.)

o T ST

FELEw
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3. Otvorite jednu sliku ili
viSe slika koje Cete
dodati novoj datoteci
— izaberite File = Open
pa odaberite sliku sa
diska. Mozete da otvo-
rite slike u ma kom for-
matu koji podrzava
Photoshop Elements,
a medu njima su JPEG,
GIF, TIF i PSD.

o LN TR T NS e

4. Kad radite s vise slika
u programu Photo-
shop Elements,
moZda Cete hteti da
otvorite Photo Bin, pri
dnu radnog prostora:
ako ved nije otvoren,
izaberite Window =
Open the Photo Bin.
[zaberite bilo koju
otvorenu sliku tako
Sto Cete pritisnuti
njen umanjeni prikaz.

PR DI T P RN e

-3

Flyrig Sroestac o) @ D00 (RO

5. Da biste kopirali otvorenu sliku
u novu datoteku, prvo odaberite
alatku za pomeranje (Move) u gor-
njem levom uglu kutije sa alatkama.

RFDEHE%;H
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) 6. Pritisnite da biste odabrali sliku
= koja tako postaje aktivna. Izaberite
~ Select = All.
A
T
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7. Kad izaberete sliku, odaberite File => Copy e
ili pritisnite kombinaciju tastera Ctrl+C W, S e
(Windows) odnosno #+C (Mac). # b
t 195 P S e
t Cma
By smmae oy
‘ L L e o B T - By
-
-b‘.', s e e et
[ —
|ﬂ B s

Caas emr e s—

8. Ovo je bitno: datoteku kojoj cete
dodati sliku treba da odaberete
pre nego §to umetnete sliku. Ako
je otvoren Photo Bin pri dnu rad-
nog prostora, odaberite je odatle.
Isto tako, na radnom prostoru
moZete da odaberete bilo koju
sliku koju tu vidite tako Sto Cete
je pritisnuti miSem.

E SEEResE s Py B s S
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9. Izaberite File > Paste, ili pritisnite
kombinaciju tastera Ctrl+V (Win-
dows) odnosno ¥#+V (Mac).

“ 3P

=

= R |
ﬂ L

i Sooke | O e | Tkt

-

il

S 10. Da bi ste pozicionirali umetnutu
sliku izaberite je pa je prevucite na
odgovarajuce mesto na novoj slici.
Za preciznije pozicioniranje kori-
stite tastere sa strelicama — moZete
da podesavate izabrani sloj piksel
po piksel, u svim smerovima. Slici
moZete promeniti veli€inu alatkom
za pomeranje — pritisnite ivice slike
alatkom i povlacite kako biste
podesili visinu i Sirinu.

11. Da biste dodali i pozi-
cionirali jos slika,
ponavljajte korake od
6 do 10. U ovom pri-
meru, paleta Layers
prikazuje tri sloja —
sloj s belom pozadi-
nom i zaseban sloj za
svaku fotografiju koja
je umetnuta u sliku.
Dok sam dodavala
slike, Photoshop Ele-
ments je automatski
dodavao slojeve.
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Shore Birds Cast Shadows @ 100% (Layer 2)

X720

¢ e o

| 712. Da biste slici dodali tekst

(bilo da slika ve¢ ima viSe slo-
jeva, kao u ovom primeru),
prvo morate izabrati alatku
za tekst iz kutije sa alatkama.

13. Kad izaberete alatku za
tekst, pri vrhu radnog
prostora pojavljuje se
nova grupa opcija. Tu
moZete da podesSavate

HhFABO%8T

opcije za tekst kao Sto
su boja (vidi se na ovoj
slici), tako §to pritisne-
te bira¢ boje da biste
otvorili paletu za izbor
boja pa onda pritisnete
boju na paleti. Koristite
kliza¢ desno od pro-
zora palete da biste
prikazali viSe boja.

14. Mozete da koristite i opcije
alatke za tekst, pri vrhu rad-
nog prostora, kako biste
promenili veliCinu i vrstu
fonta, te poravnanje teksta.
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Ukljucivanje, iskljucivanje i promena redosleda slojeva

Kad radite na slici s mnogo slojeva, pone-
kad je korisno da ih ukljucujete i iskljucujete
kako biste isprobavali razlicite kombinacije
ili ocistili radnu povrsinu dok se bavite de-
taljima. Pritiskanjem slicice oka levo od slo-
ja, posticete da sloj na radnoj povrsini bude
nevidljiv. Ne brinite - sloj lako moZzete pov-
ratiti ako ponovo pritisnete isto polje kako
bi se opet pojavila slicica oka. U tome je le-

pota ove opcije: Cas vidite slojeve, ¢as ih ne
vidite.

Redosled slojeva na paleti Layers moze-
te promeniti i tako odrediti koji se sloj slike
pojavljuje na vrhu. Da biste promenili re-
dosled slojeva, pritisnite sloj i odvucite ga
gore ili dole na paleti Layers. Sto je vise po-
zicioniran sloj na paleti, to je visa njegova
pozicija medu slojevima u dokumentu.

15. Na sliku upisujete tekst kad
pritisnete miSem da biste
postavili kursor na odgovara-
juce mesto i onda kucate.
Slici moZete dodati tekst
proizvoljne duZine. Pritisnite
Enter (Return) da biste
dodali znak za prekid reda.

lwopd

Ha DL

16. Za uredivanje teksta koji ste
otkucali moZete da koristite i
opcije za tekst pri vrhu rad-
nog prostora. Izaberite tekst

- imaamar g ggss  BCLTEETIE N -

koji hocete da izmenite, pa a e ————
odaberite opcije formati- ¥ o ey
ranja kako biste promenili ": e e e
boju, font, veli¢inu teksta ili a - —- v
neke druge parametre. Da . v rmis uma

. . STe s i F = Beach
biste izmenili reci, pritisnite T ; _ =i
i izaberite sam tekst pa ga ; : = }
obriSite ili dopunite.

17. Kad dodajete tekst, Photo-

shop automatski ubacuje nov
sloj koji se pojavljuje na pale-
ti Layers. Da biste premestili
ili izmenili sloj, morate prvo
izabrati alatku za pomeranje
iz kutije sa alatkama. Photo-
shop Elements automatski
bira sloj kad ga pritisnete.
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18. Ukoliko se sloj ne vidi u rad-
nom prostoru, izaberite ga
na paleti Layers tako sto
Cete ga pritisnuti miSem.
Photoshop Elements prika-
zuje sadrzZaj svakog sloja da
biste lakSe uocili sloj koji
hocete da izaberete.

19. Da biste sloj jos lakse
prepoznali medu drugim
slojevima, promenite mu
ime: desnim tasterom
miSa pritisnite sloj pa
odaberite stavku Rename
Layer da otvorite okvir
za dijalog Layer Proper-
ties gde upisujete novo
ime.

20. Mozete nastaviti da
unedogled dodajete
slojeve teksta i slike,
da ih obradujete i
prilagodavate pona-
vljajuci navedene
korake. Jedan od naj-
boljih nacina da se
naviknete na rad u
programu Photoshop
Elements jeste da
izvesno vreme posve-
tite isprobavanju raz-
nih kombinacija
teksta i slika na viSe
slojeva.

b e R § R TEET BT T

TR cqirmwl
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Obrada slika sa vise slojeva

Stavam je potrebno

v’ Adobe Photoshop Elements
(ili slican program koji
podrzava slojeve)

v Digitalna slika sa vie slojeva

Vreme:
»& Manje od pola sata

U programima kao Sto je Photoshop Elements, medu
odlikama koje najvise zbunjuju korisnike spada i nacin
podele razlicitih delova slike na slojeve. U osnovi, slo-
jevi omogucavaju programu da podeli sliku na vise
odeljaka koji se mogu nezavisno obradivati. Zato
moZete da uredujete tekst a da to ne utice na fotogra-
fiju ispod njega ili da premestate zasebne fotografije
sve dok ih ne postavite kako vam odgovara.

Bez slojeva, tekst bi bio zakacen za fotografiju ili
baner, kao u primeru koji ovde obradujemo, i ne biste
mogli da ga menjate nakon §to ga dodate slici. Slojevi
su narocito korisni kad prilagodavate banere, dug-
mad i druge graficke elemente ubacene u Sablone koji
su opisani u ovoj knjizi.

Kad dodajete tekst, fotografije ili druge elemente novoj ili postojecoj datoteci, Photo-
shop Elements automatski pravi nov sloj za svaku dodatu stavku. Ti slojevi se zatim
mogu nezavisno uredivati. Pre nego Sto predete na uredivanje teksta ili obradu slike
sa slojem, morate da izaberete odgovarajuci sloj. Tu na scenu stupa paleta Layers, Sto

Cete videti u ovom zadatku.

1. U programu Photo-
shop Elements otvo-
rite postojecu sliku
koja ima viSe slojeva,
kao Sto je ovaj baner.

HOm I [

e 2. Izaberite Window = Layers da biste
Horma S otvorili paletu Layers. Na paleti Lay-

ers pritisnite i tako izaberite sloj koji

® | Fhota Gallery  Web Design
LaFontaine Multimedia
> |l Lo 4

0 hocete da uredujete. U ovom primeru
izabrala sam sloj s reCima LaFontaine
Multimedia.

L ——
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3. U kutiji sa alatkama izaberite
alatku kako biste promenili sadr-
Zaj sloja. U ovom primeru izabrala
sam alatku za tekst kako bih izme-
nila reci.

Bei N

L

S T

|

4. Primenite izabranu alatku da biste
izmenili odabranu sliku. U ovom
primeru dvaput sam pritisnula ime
LaFontaine da bih ga izabrala pa
sam umesto njega upisala ime
Warner.

xR I A

Ha AR R

5. Da biste uredili tekst na dru-
gom sloju, ponovo izaberite
odgovarajuci sloj na paleti
Layers. Ovde sam izabrala
sloj s tekstom u donjem de-
snom uglu banera. Posto je
alatka za tekst vec aktivna,
samo sam izabrala tekst koji
hocu da izmenim i upisala
novi tekst.

6. Nakon 5to unesete izmene, izaberite
File => Save As i upiSite novo ime slike.
Tako ¢ete sacuvati izmenu a necete
promeniti originalnu sliku.
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Koriscenje specijalnih efekata

. . Photoshop Elements sadrZi obimnu zbirku specijal-
nih efekata, medu kojima su i filtri, stilovi slojeva i
v Adobe Photoshop Elements foto-efekti. Pomocu tih opcija dodajete senke slikama
ili tekstu, pravite oborene ivice, pa cak postiZete

umetnicki ,Smek*“, kao kad primenjujete slikarske
efekte prikazane u ovom zadatku.

(ili lican program koji
podrzava efekte)
v Digitalna fotografija

Vreme:
»& Manje od pola sata

1. U programu Photoshop Ele-
ments izaberite File &> New
da biste napravili novu sliku,
odnosno File => Open da
biste otvorili postojecu.
Zatim otvorite paletu Art-
work and Effects bilo tako
Sto Cete pritisnuti strelicu
pored palete ili tako Sto cete
izabrati Window = Artwork
and Effects.

EEWwT W

o i T s

2. Paleta Layers neka bude otvorena kako biste bili sigurni
da efekte primenjujete na pravi sloj. (Paletu otvarate kad
izaberete Window = Layers.) Pritiskanjem i povlacenjem
gornje ivice palete moZete je prosiriti ili smanjiti da bi
zauzela viSe ili manje mesta bo¢no od radnog prostora.
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3. Paleta Artwork and Effects ima mnogo
opcija. S jedne grupe opcija na drugu
prelazite tako Sto pritiskate ikonice
kategorija duz vrha palete i iz padaju-
¢ih lista birate zbirku opcija u svakoj
kategoriji, recimo opcije filtara kao na
ovoj slici.

4. Da biste primenili filtar ili
neki drugi efekat, pritisnite
i izaberite sloj na koji hoce-
te da primenite efekat pa
onda dvaput pritisnite iko-
nicu sloja na paleti Layers.
U ovom primeru, izabrala
sam sloj s fotografijom i
dvaput sam pritisnula filtar
Cutout kako bih otvorila
njegov okvir za dijalog.
Svaki filtar za umetnicke
efekte ima okvir za dijalog
slican ovome u kome po-
desavate efekte. Na levoj
strani okvira za dijalog nala-
zi se prikaz slike u kome vi-
dite kako primenjeni filtar
utiCe na sliku.
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5. Pritisnite OK da biste prime-
nili filtar na sliku pa zatvorite
okvir za dijalog. [zaberite Edit
> Undo kako biste ponistili
dejstvo filtra. Da biste pode-
sili parametre filtra, dvaput
pritisnite ikonicu filtra na pa-
leti Special Effects i ponovo
Cete otvoriti okvir za dijalog.

6. Da biste primenili filtre na tekst,
na primer senku, pritisnite slovo T
pri vrhu palete. Prikazace se
opcije za efekte koji se primenjuju
na tekst. U ovom primeru izabrala
sam sloj s tekstom Beach Walks.
Prvo izaberite sloj s tekstom, pa
dvaput pritisnite odgovarajucu
opciju za tekst. Opcija se automat-
ski primenjuje na tekst.

Da biste uklonili filtar za tekst,
izaberite Edit => Undo. Drugi
filtar primenicete tako Sto
Cete dvaput pritisnuti alatku
za tekst. U ovom primeru,
uklonila sam senku i umesto
nje sam primenila filtar Bevel.
SloZenije efekte dobicete ako
primenite viSe filtara na isti
element.

GNET

Da biste usavrsili tehniku obrade fotografija, neophodno je mnogo prakse, a najbolje
Cete je steci ako eksperimentiSete. Ucenje pomocu pokusaja i pogresaka narocito je
bitno kad radite s naprednim tehnikama, kao Sto su filtri i specijalni efekti. Primenju-
juci razlicite filtre na tekst i slike ne biste li videli kako izgledaju, odlican je nacin da
otkrijete Sta sve moZete postici sa ovim zanimljivim funkcijama.



